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1 Introduction

1.1 PURPOSE

The purpose of this document is to describe howCyehat project will be developed. This
document specifies the different sub-systems optbgct and the interfaces between them in
order to concurrently develop different parts & groject. The data in this document is intended
for the developers so that they know what exaatklds to be done for successful completion of the

project.

1.2 SCOPE

This document defines the sub-systems of the prajet outlines the services of each. Detailed
information is given on the different processesugings and states of the project. The interfaces
between the different sub-systems are exhaustdedfiped. Exact implementation of the sub-
systems and their components is not given, but saloksystem’s required behaviors, actions, and

interfaces are specified.

1.3 DEFINITIONS, ACRONYMS, ABBREVIATIONS

Term Description

Action area An area inside of a room that has @eseside script associated with it.
Instead of moving to that spot when the user clinkgle the action
area, the server executes the script. The userdasy to tell if an area
is an action area unless the background or imagptagied by the

server indicate that it is one.

Avatar The visual appearance of a user. This casthbeged by the user and |s

then made visible to all other users in the samero

Bookmark A saved configuration of a server thatlsn previously visited. A

bookmark consists of server name, network addeegsport.

Client The program used by the user to connectsireer. It has a graphical

interface to display information and the room inietithe user is.
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Closet

The local collection of Avatars available Wearing by a user. Avatar
can be imported into the closet. This Closet isestdocally on the

user’'s computer.

U

Dewear

To remove an avatar from use.

Image item

An image that can be seen by all useasroom that is
not static like the room's background and is net«®ntrolled like an
Avatar. They can be modified by action areas.

Room

A specific "channel” in a chat server. A usen one room at one time
on a server. Normally, messages sent go to alllpenphe same room
as the sender (with the exception of whispers doloalmessages).

Rooms are visually represented as a rectangleaniidockground image
downloaded from the server.

Server

The program used by the developer to satagmmon area for users
chat in. It manages all of the rooms and clientseated to it. "Server'
may also be used as a general term for the caleofirooms and
scripts that the server program is composed of.

Wear

To use an avatar. A user is said to be wgarnavatar when

It is in use as the user's visual representation.

World

The collection of rooms hosted on a server

CyChat
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1.4 DESIGN GOALS
1. Extensibility — CyChat is intended to be a verysatile product. With the ability for

people to develop their own servers and defineyghielg from Room features to action
areas, it is very important that the System Adman&sativity is not limited.

2. Response Time — As this is a chat program, respiimses obviously a very important
issue. In development, lag and response time dhmub primary concern. This refers to
the loading time of rooms as well as response tanehat messages between users.

3. Reliability — The final product should be a welhning product with no unexpected errors.
Extensive testing, in collaboration with clean capstandards, should be employed to
ensure this.

4. Maintainability — CyChat should be developed inasrthat it may be updated or expanded
later on. New features may be desired at a latt, do it's important to use good coding
standards and sufficient documentation so that teaamce is possible.
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3 Decomposition Description

3.1 MODULE DECOMPOSITION

—

Server

\—|

[ ]

Client Connection

Client Room GUI

Message
«subsystem» «subsystem» «subsystem»
Server to Client Shared Client to Server

3.1.1 <Server>
the server program

Server authenticates users

[ 1

Client Control GUI

Server manages world state data such as roomareetd action areas

Server relays messages to users

Server activates scripts

Server provides status information to Administrato

CyChat
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3.1.2 <Messages>
contains objects that both the client and serveseu

. Defines data types sent between server aek @s messages such as Avatars, Image

Items, ect.

3.1.3 <Client Connection>
Part of the client that is connected to the server

. Connects to server
. Relays messages from user to server
. Determines action based on messages from server

3.1.4 <Client Control GUI>
GUI that handles inputs and outputs from the usexcept in the room window.

. Reads user settings file
. Generates and displays menus and frames (incliRbogn GUI)
. Takes user input (connect, room change, useeligtest, etc) and activates appropriate

client connection methods

. Accepts user chat input

3.1.5 <Client Room GUI>
GUI that handles the room window and all associdt@puts

. Displays state of the room including usertarsa

. Displays chat bubbles

. Takes user click events and relays data to Cemnection

. Caches image items, avatars from other usershackfjrounds

3.2 CONCURRENT PROCESS

3.2.1 <Server >
Communicates with the client and processes data
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* Main thread : waits for a client to connect

» Client Connection thread: runs when a client cotsyand waits for messages

3.2.2 <Client>
Communicates with sever and interprets data sent

* Main thread: launches GUI

» Server Connection Thread: run when the client cotsn® server and waits for server messages

3.3 DATA DECOMPOSITION

3.3.1 <Settings file>
The settings file is used to keep track of inforrmat that the client needs to retain between

instances.

* The settings file is stored locally by the client

* Filename is cychatsettings

» Ifthe file doesn't exist, it is created.

* File stores the last used server, port, and usexnam
» File stores server bookmarks (name, address, port)
» The SettingsHandler class controls the settings fil

* File is read when the client opens, and is writtdaen the client closes.

3.3.2 <Server World Data>
The server's world state data will be defined it@mposite class encapsulated by the ServerState

class. The data will be populated by the servedsfagyuration script file on server startup.

CyChat Decomposition Description Page 9 of 26



* Server Name

» Server Message of the Day

* Maximum Server Capacity

* Room List

Each room (defined by a RoomState object) will caintadditional world data, also created by
the configuration script:

* Room Name

*  Maximum Room Capacity

* Background File Name

* Action Area List

3.3.3 <Avatar Data>
The Avatar data is all of the necessary data thedakas up a users avatar in the world and also

data to identify different avatars as unique.
e Avatar Image

* Avatar Checksum

* Avatar Filename

e Avatar name

3.3.4 <Localization File>
This file is an XMl file containing translation dehitions for GUI messages and titles. Users

can create these XMl files to create translatiorms messages and titles in CyChat.
» Defines UTF format of XML to define Unicode format.

* Root node

* Name of language translation

» Specific translations of messages and titles in GUI

3.4 STATES
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3.4.1 <Logged Off >
When a user is logged off, the only available apisto log on to a server. While logged

off the user may still change languages, changgdate avatars, and view debug logs but

no chat or interactive functions are available.

3.4.2 <Logged On>
When a user is logged on all functions are avalablthe user except changing server in

which case they must first log off.

3.4.3 <State Diagram>
/11(!1 We could only think of 2 states for our @am and asked professor Mitra if he thought it

was ok and he agreed that we would really only hbge?.)
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[Logged Off)

(Logged On)
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4 Dependency Description

4.1 INTERMODULE DEPENDENCIES

4.1.1 Server
Uses data types defined in the Common package

Uses messages from Client Connection.
Provides server information to Client Connection.
Provides world state data to Client Connection.

Provides messages to Client Connection.

4.1.2 Message
Provides data types to Server.

Provides data types to Client Connection.

4.1.3 Client Connection
Uses data types defined in the Common package

Uses messages from the Server to determine apat®@pction.
Provides state changes to Client Room GUI.

Provides messages to Client Room GUI.

Provides server information to Client Control GUI.

Uses user input from Client Control GUI.

Uses user input from Client Room GUI.

Uses messages from Client Control GUI.

Provides user input to Server

Provides messages to Server
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4.1.4 Client Control GUI
Uses Client Connection to retrieve server data sisatlmom list, user list, etc.

Uses Client Room GUI to display the world.
Provides user input (connect, room change, udaeligiest, etc.) to Client Connection.
Provides messages to Client Connection.

4.1.5 Client Room GUI
Uses state data from Client Connection to displasidv

Uses messages from Client Connection to displaiyroleasages.
Provides user click event data to Client Connection

4.2 INTERPROCESS DEPENDENCIES

Client Server

GUlI thread Client to Server Connection
Thread

Listening Thread Server to Client ConnetionThread

T
\ ‘ \
\
[
[
[

|
|
GUI initiates Connection } attempts connection

T
|
|
|
|
|
|
|
|
1

creation of thread

Connection Successful
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4.3 DATA DEPENDENCIES

CyChat Client] [ CyChat Server|
Localization File| | Settings File | | Avatar Data | |Server World Data Other Users CyChat Client
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5 Interface Description

5.1 MODULE INTERFACE

5.1.1 <Server> Interface
e Server<«—» Client Connection

TCP/IP
Java Sockets

Object Serialization

Protocol Description:

The server interface operates by sending java otgjetored in the messages package through the
connection between the server and client connectidhese objects act as messages between the
two and contain all the necessary information toeate. A description of what messages and

how they are sent follows.
(All points marked with bullets are objects stonedhe messages package.)

To logon, client sends...

» ServerRxLogonInfo

Server replies with (if successful)...
» ClientRxServerinfo

* ClientRxRoominfo

» ClientRxUserInfo

Or replies with (if unsuccessful)...

e ClientRxError

To send globals, whispers, and room chat, clientsesd...
e ServerRxChat

Server replies with...
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» ClientRxChat (to all users intended to get the mgssnd always to the sender)

To update the user's avatar, the client can send...
» ServerRxUserInfo
Server replies with...

* ClientRxUserInfo (to all users in room)

To get a current user listing, client can send...

» ServerRxUserListRequest

Server replies with...

¢ ClientRxUserList

To get a current room listing, client can send...
» ServerRxRoomListRequest
Server replies with...

* ClientRxRoomList

To change rooms, client can send...

* ServerRxRoomChange

Server replies with...

* ClientRxRoominfo (to the moving user)

* ClientRxUserLetft (to all users in the old room)

» ClientRxUserInfo (to all users in the new room démel moving user)

To get uncached backgrounds and image items, dansend...
» ServerRxFileRequest

Server replies with...

* ClientRxFile

To perform moderator actions, client can send...

CyChat Interface Description
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* ServerRxModAction
Server replies with (only when unsuccessful)...

e ClientRxError

To get uncached remote user avatars, client cah.sen

* AvatarRequest

Server replies with...

e Avatar

To get and distribute new user avatars, servesead...
* AvatarRequest
Client replies with...

e Avatar

e Server+—> Message

Creates Objects: the server creates instancegeaiftsistored in the Message module

5.1.2 <Client Connection> Interface
« Client Connection® Server

TCP/IP
Java Sockets

Object Serialization

CyChat Interface Description
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« Client Connection > Message

Uses data types: the client uses data types frervidssage module
» Client Connection—— Client Room GUI

Clear room: clears the room of all users

Set room name: sets the room name

Load room image: loads the background image ofdben

Update user location: updates where the user'saaisin the room
Update user avatar: updates any change in the asatiar

Remove user: removes the user from the room

Show room chat

Show global ch (Currently show bubble): showat @ a bubble on screen
Show whisper ch

» Client Connection—— Client Control GUI

Fatal server error: Server suffers a fatal errar laas to shut down
Server error: server suffers an error

Update room list: updates the list of rooms inwweld

Update user list: updates the list of users inntbdd

5.1.3 <Client room GUI>
e Client Room GU+H—> Client Connection

Send location: sends information about user’s a\gl@cation
Request avatar: sends request for an avatar irhagestnot locally stored
Request file: sends request for a file

Request image item: send request for an imagethatrs not locally stored
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5.1.4 <Client Control GUI>
e Client Control GUT—" Client Connection

Activates start: starts the client program

Activates stop: stops the client program

Chang room: changes the room the user is in

Request room list: sends request for a list of r@amthe world
Request user list: sends request for a list ofsusethe world
Send chat: sends chat

5.1.5 <Message>
e Server+—> Message

Creates Objects: the server creates instancegaiftsistored in the Message module
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5.2 PROCESS INTERFACE

5.2.1 <Client>
Implemented through subclassing of the built-in javang.Thread class.

* GUI Thread (Event Dispatch Thread)

For the client's GUI, the Java Swing library wil bsed. This means that all actions that the client
takes are run on the Swing Event Dispatch Threas.automatically started and stopped when the
main program window is closed, which correspond$i¢ostart and stop of the entire client
program.

» Client-Server Connection Thread

Inside the Client Connection package, there wilalibread called "Server Connection Thread" that
listens for messages from the server. It will lzgtetl by the Server Connection Handler in the
Connection package whenever a connection is iediby the Client Control GUI module. If the
server requests a disconnect or there is a commeetror, the thread will deactivate itself and
inform the Server Connection Handler that the cohae has terminated. If the Server Connection
Handler requires a disconnect (when requested fhenControl GUI module), it will close the
connection stream and the thread receives a discoerception. When this occurs, the thread

then ends itself.

Technically, the client has a third thread: themmiva thread. This thread is blocked throughout

the course of the program because it blocks oGtheThread.

5.2.2 <Server>
Implemented through subclassing of the built-in javang.Thread class.

» Listening Thread

This is the server's primary thread, which will thnoughout the course of the program (i.e. it will
be started when the program is launched and end telminated). It will listen for incoming
client connection requests and, when it receives bnvill create a new Server-Client Connection
Thread.
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» Server-Client Connection Threads

These threads, defined in the Server package veeaed process incoming messages from
connected clients. A new one is created by theshiag Thread for every client that connects to
the server. It is ended similarly to the Clientislagous connection thread: it will terminate itsel
when such a request is made (when the server dowts or due to a kick/ban command

initiated by a different Connection thread) or wizedisconnect condition (I/O exception) arises.
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6 Detailed Design

JAVA DOCS will be used in our program to give adlined detailed design
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7 Design Rationale

7.1 DESIGN ISSUES

7.1.1 <Avatars>
Issue: way to have user uploadable avatars.

Design issues were encountered with the passingtanidg of avatars. These were encountered as
a result of our design decision to allow usersge their own custom avatars, and the decision to
not store them on the server. This makes it diffiag a user adding an avatar has to send it to the
server and then distribute it to all clients thatibare in the same room and do not already have th
file locally cached on their machine. Once a clieteives the file they then must cache it locally

to be stored if they chat with the same personnaddiis requires use of a list of the checksums of
the avatar images to track which ones are alreathed and which are needed.

An alternative design to this would be to allow #watars to be cached on the server but that
would ruin our design of a highly mobile and easgét up server.

7.1.2 <Defining Interactive World Elements>
Issue: There needs to be a way to define worlderint

Factors affecting issue:
Need to define action areas
Ease of use and Readability and Maintainability

Needs an existing extensive package for java

One way to implement world content is to use d&bnifiles such as XML files. Such a file would
allow the server administrator to define roomsmnatames, room backgrounds, etc. but not the
interactive content. For such content (i.e. aciogas), to fulfill the requirements of the Action
Area to allow modification of “state variables” wiould seem natural to use a scripting language,
which has variables, as opposed to XML. This alltivesserver administrator to combine the static

and dynamic portions of the world into one confagion file. Additionally, existing functionalities
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can be imported and reused. Thus we decided ta asapting package for world definition.
Jython. Jython is almost nearly completely impletagrython which means python scriptwriters
are able to easily create Worlds and because pyshoopular, it is easy to find reference material
for it. Python is very simple. Jython allows scwpters to directly use existing java classes withi
python code and allow CyChat to provide java olgjéat the scriptwriter to work with. LuaJava is
an alternative to Jython with similar capabilitisswever, it would require the CyChat developers
to learn Lua as opposed to using our existing kedgeé of python. Additionally, the developers
are more familiar with using Jython. One advantageua is that it is used widely in the gaming
industry (eg. World of Warcraft) so that many stwigters are already familiar with it.

We picked Jython, it fits our requirements. Itldeato define action areas naturally using
object oriented features. It is easy to use, amhyiknown with many available resources. Finally,
Jython is an extensive and well tested implementati
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8 Traceability

8.1.1

No UseCase/ Non-functional Description

Subsystem/M odulée/classes that handlesit

FEEL FREE TO ADD APPENDICES AS NEEDED. UPDATE TOEBORE SUBMITTING
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